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Version Update: September 2010

REGISTRATION OF EASYPLAN

EasyPlan requires a Licence and Registration Key to activate the software.
Insert the CD and follow the prompts to install. When the Registration window appears, click on Register Online and enter your Program
ID. Click Begin Registration then fill in all details. The EasyPlan Device ID will be emailed to our system and a Program Key will then be
emailed to you and this must be used to licence and register your software on one computer. A second computer requires a different
Program Key since the Device ID will be different.
Should you have any problems with the online registration process, please contact us.
 Registration of this product qualifies the legal user for a one-year FREE subscription to downloadable data updates or program
amendments, thereafter an annual subscription fee applies.

Welcome
Thank you for using EasyPlan Flight Planning Software Version 3.0
In view of flight safety we offer you, for one year from date of registration, free updated flight information that can be downloaded from
our website: www.easyplan.co.za.
In addition, we also offer free Notam on our website: www.aviationdirect.co.za
We would like your opinion and/or suggestions for improvements and enhancements.
Please also advise us of any errors and/or omission by emailing: support@easyplan.co.za
Enjoy the Flying!
Stephen Hunter and the team at Aviation.Direct

HELPLINE:

email to: stephen@easyplan.co.za or
info@aviationdirect.co.za
or call
Andrea @ Aviation.Direct Tel. 011 465 2669 or 072 340 9943

D I S C L A I M E R

This program is intended for VFR use only.
Whilst every care has been taken to ensure the data and the calculations are correct, we
cannot be held responsible for any errors and/or omissions. It is the Pilots' responsibility to
verify the accuracy of all information and subsequent flight plans with official sources and information before flight.
COPYRIGHT: ©2009 Stephen Hunter & AviationDirect. All rights reserved.

Recommended System Requirements for
EasyPlan Version 3.0:
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Getting Started
The Toolbar:

New/Save/Print Function
when pressing this printer icon, only the
page shown on the screen will print,
whereas under File - Print, the entire
document can be printed.



Task buttons: Insert/Remove Descent
Waypoints, Enable/Disable Alternate
Airfields, Autoscale, Zoom In/Out

Click these Layer icons to choose
what you want to see on screen.

Tip: When moving the mouse over the icon, a description panel will come up.

STEP 1 - set your USER PREFERENCES
Enter your preferred units and preferences, which will be automatically saved
on exit.
Display Preferences:
General
 Display Seconds : Display flight times in hours : minutes : seconds.
Default is set to hours : minutes.
 Latitude/Longitude : Select display mode.
 Select preferred units of measurement. You can also change Units by click
ing on them. (e.g. in FlightLog window)
Flight Log
 Offset Columns : Enroute information,
applicable on the leg between two points, is displayed offset between the two points.
 Display Short Headings : Display abbreviated headings in flight log
 Print Clearances form : Prints form to write down ATC clearances, and enroute navigation info.
 Print Notes : Prints notes associated with this route.
 Print Airfield Info : Additional information on airfields, contained in the EasyPlan database, that are part of the route can
be printed with the flight log. Select the size required. Select “Small” and then print in Landscape mode -works well for
creating a printout that can be used on an A5 kneeboard. Switch off "Print Clearances", "Print Notes", "Print Airfield Info"
and select Landscape mode to print the Flight Log across the entire width of an A4 page.
Flight Log Print Format
 Normal - Prints the flight log as displayed on the screen, using the same columns selected.
 Fixed Format x : Recommended print setting. Prints the flight log in a fixed format irrespective of the columns selected.
This mode automatically detects if wind has been entered, and modifies the printout accordingly.
The order of the displayed and printed columns of the Flight log can be rearranged.:
Left Click and hold down on the Column Name; move to desired position while holding down the mouse key. Then
release. This option only works when no flight plan/log is open.



Tip: Columns can also be taken off in the Flight Log window.
Note: If EasyPlan detects an error in this file, the default column order is used.
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DISPLAY OF MAP GROUND FEATURES & PRINTIN G M AP
 Select the items to be displayed on the map.
 The elevation can be displayed using darker colours for the higher ground, or using a 3D effect.
 Hi Definition Elevation. High definition elevation data will be displayed when zooming in, if the files are available.
This option uses new data supplied by NASA with a resolution of about 90 meters.
The *.hgt files are in the \Dem directory. They are loaded as required using up to 800 MEG of memory.
 Filter Level: Select “Main” or “National” to display only main or national roads irrespective of the zoom.
 Auto Filter Detail: if enabled, less terrain detail is displayed as one zooms out, and more detail as one zooms in.
Select “Less Detail” if the map is too cluttered.
 Ground Feature Hint If this feature is enabled, then as the mouse is moved over an item the name will be displayed,
and if the Highlight option is selected, the colour will turn green.
Note this option only works in South Africa with the updated Terrain Data Base.
 Print Vertical Nav: - Prints the vertical navigation information along with the map.
 Print In Black :- Some of the lighter colours are not printed when printing in black. Select this option so that all items on
the map are printed in black.
 Print Terrain Elevation :- Recommended off. When ON prints the shaded background of the
elevation in light or normal colour. This can take a LONG time. If the function does not work with your printer then use
“File” “Print” “Print Map to File” to create a bitmap that contains an image of the map.
“PrintFile.bmp” in the “c:\Program Files\EasyPlan\EasyPlan3” folder. This can be printed from a program like Word.
AERONAUTICAL BORDERS
Select the border thickness for items such as TMA’s, FAD’s etc. “Auto” selects thick borders when the ground features are displayed, and thin borders when the ground features are switched off.
AERONAUTICAL SYMBOLS
Selects the size of the symbols, i.e. Airfields, NDBs. Auto scales the size according to display zoom.
AIRFIELD FILTER
Select which airfields to display on the map. Note that “Microlight Only” may exclude some airfields that are suitable for
light aircraft and microlights.
REPORTING POINT FILTER
Select which reporting points to view on the map.
DISPLAY LABELS
Select which items to label on the map. Note that the display “Display Labels” button at the top of the page
must be selected.
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M A P CO LO U R S
Selecting Map Colours
The colours of all the items can be changed by clicking on the coloured blocks.
Press the [+] or [-] next to “Get Colour” to get the previous or next colour. This is useful for the elevation colours when each
colour is an incremental change from the previous.
Press ok to confirm the change.
FLIGHT PLAN
 Automatically Update Flight Plan: - All route changes are automatically updated in the Flight Plan. If you have made some
special changes to the Flight Plan, and don’t want them over-written, clear this option.
 Use cruising Speed: Use the aircraft cruising speed in the Flight Plan. This is the preferred way.
 Select the country to display the country name on the Flight Plan heading
LOGBOOK
Note: The logbook format shows the latest Part 61
logbook layout. You can use different logbooks
if you need to keep separate logbooks for fixed
wing, rotary, simulator. The Part62 Recreational
Logbook in its simpler format is approved for
recreational flying, gliding or microlighting.
However, remember if you intend to upgrade to
Commercial licence or Instrument Flying, you will
require the Part61 logbook entries.
 Select small and/or narrow fonts to display
and print more digits if the decimal or
min utes are being rounded off.
 Select the active Log Book. When the
active Log Book is changed the current
Log Book is saved and the new one opened. Note: The Log Books are maintained completely separately.
 You have the option of selecting the number of lines on a logbook page.
 Column Selection: you can deselect columns that are not required, i.e. Instructor, Simulator, or PICUS
"Comply CAR 91 accepts an A, B, C or nothing to indicate the type of approach, but it is no longer a requirement.
Cross Country accepts an ‘x’ to indicate cross country flight
 Select “Magnify Logbook Display” to enlarge the display of the Log Book on the screen.
 Page Set Up: allows to print logbook page or summary on a single A4 landscape page
 Remove All Page Breaks - Removes all page breaks from the active Log Book.
Time format display: choose the time format display, however, the logbook renewal form requires hours in Decimals.
 Sort By Date - Sorts all entries by date. Useful if data has not been entered in date order.
TOOL S
A simple calculator, which will automatically work out Standard Rate Turn, Density Altitude, Sunrise & Sunset values, and
Distance to the Horizon.
Operation
 The numbers displayed in blue can be changed.
Right Click to decrease and Left Click to increase a value.
 Pressing Ctrl while clicking changes the value by 10 or 100 for the Pressure Altitude.
 Left Click on the ‘Units’ to change to your preference.
 No range checking is done on the input values.
 TAS in Standard Rate Turns is used to calculate the IAS in the Density Altitude.
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STEP 2 - set your AIRCRAFT DATA
WEIGHT & BALANCE
The Weight & Balance does not verify if the limit is exceeded but provides an easy way for you to see what is the resulting
Weight & Balance. You require your Aircraft Manual for the correct information, however, you can select an aircraft similar to
yours from our list but still need to check the figures from your own manual.
The graph connects all the points described in the Aircraft limits and superimposes the aircraft Weight & Balance with fuel as
specified, and with no fuel.

CALCULATIONS






Left Click on a value to change it.
Right Click in the 1st column to add or delete a row.
Click on the ‘Units’ to change to your preference.
Right Click on the Graph to change type
An item with a name starting with "Fuel..." is interpreted as Fuel and is displayed
in a different colour. More than one Fuel item can be entered.
The total fuel is used for the Fuel Calculations. EXCEPT....
 An item with a name starting with “Fuel-Aux-s” (Separate Aux Fuel) is interpreted as fuel carried in or on the aircraft but
not available unless there is a fuel stop. (See Flight Log)
This quantity is not used in the fuel calculations except when there is an en-route fuel stop.

AIRCRAFT LIMITS
 Left Click on a value to change it.
 Right Click in the 1st column to add or delete a row.
 Left Click on the ‘Units’ to change to your preference.
Note : The arm or the moment can be entered; the other will be
calculated automatically.
The space for fuel calculations can be re-sized by clicking and
dragging the top of the panel.
En-route fuel stops are ignored for fuel calculations.
 Note: Either arm or moment can be entered; the other will be calculated automatically.

AIRCR AFT PERFORMANCE
Enter your Aircraft Defaults.
 Left Click on the light blue numbers to enter new data.
 Left Click on the ‘Units’ to change to your preference.
 The default values of Speed, Height and Fuel Consumption are used as initial
values for the Flight Log.
 The compass deviation is subtracted from the magnetic heading to get the
compass heading.
 The Fuel calculations are calculated from the Performance data, the flight details
in the Flight Log and the Fuel quantity in the Weight & Balance.
 Or import existing aircraft data from the Route/Aircraft menu.
 Note: After updating the Weight & Balance and the performance details of
your aircraft,
click on File  SaveAs and enter a name that describes your aircraft.


Tip: all numbers in BLUE can be changed.
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STEP 3 - Plan your Flight in MAP VIEW

EasyPlan

Almost an entire route can be entered from the Map view by RIGHT clicking on your departure
airport, then your destination airport. To add boundary points first LEFT click on the track line, then RIGHT click for the
options to add. Here are some tips on how to do this:

Display
 Use the top buttons to switch on or off
display of airfields, restricted areas,
reporting points, navigation aids etc.
 Ground features can also be switched
off for easier viewing. Click
 Go to ‘Units & Preferences’ to
switch on or off the ground features, as required.

Zooming with buttons
 Use the Auto Scale button to view the route.
 Use the + and - buttons to zoom in and out.
 Use the Display South Africa button to display the
whole map.

Zooming with mouse
 Right click on a free part of the map and select the PopUp menu item to Zoom in and out.
 Best way: Press and hold the Ctrl button on the keyboard. Press and hold the Left Mouse Button and move over the area
that you want to view, then release, or use Mouse Wheel

Panning
 Press and hold the Left Mouse Button down and then move. The map will follow the mouse.

Measuring Distance
 Press and hold the Shift button and then press and hold the Left Mouse Button.
Move the mouse and the distance and magnetic bearing will be displayed at the bottom of the screen.

Displaying Information
 An aeronautical item on the map will be highlighted in lime green as the mouse moves over it.
 Right Click and go to Display Details to display additional info on the item.

Rou te
Adding a Point - to the end of a route
 Make sure no leg is selected. De-select a selected leg by Left Clicking on the highlighted leg.
 Switch on the points of interest. (Airfield, NDB etc).
 Right Click on the highlighted point and go to the Add menu item.
Inserting a Point - in an existing leg
 Left Click on the leg to select it.
 Switch on the points of interest. (Airfield, NDB etc).
 Right click on the highlighted point and go the Insert menu item.
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Inserting a Flight Boundary - in an existing leg
 Left Click on the leg to select it.
 Switch on the boundary of interest. (FIR, TMA etc.)
 Right click on the highlighted boundary and go the Insert menu item, or
 select from the menu ”Flight Boundary”
Inserting a Waypoint - in an existing leg
 Left Click on the leg to select it.
 Make sure no point is highlighted, Right click on the map and go the Insert Waypoint
menu item (a Waypoint can be inserted on the leg or at the mouse position).
Radial from ... (any VOR)
 Left Click on the leg to select it.
 Move the mouse over the VOR Right Click. Select the menu item
“Radial from xxx”. The "insert waypoint" menu is displayed.
Inserting a Waypoint abeam of an existing point - in an existing leg
 Left Click on the leg to select it.
 Move the mouse over the point abeam the selected leg and Right Click. Select the menu item
Insert Waypoint Abeam xxxx. If the menu is not available then the point is not abeam the leg.
Deleting a Point or Waypoint
 Left Click on leg to select. (Note - the highlighted point is the selected one).
 Ensure that no additional point is highlighted (maybe switch off some of the displayed points)
 Right Click on the Map and go to the Delete menu item.
Viewing Details
 Select the leg by Clicking with the Left Mouse button.
 Ensure that no additional point is highlighted. (maybe switch off some of the displayed points)
 Right Click on the Map and go to the Display Leg Details menu item.
Map Notes
 Right click on a boundary and select Details to Notes to send the details to the route notes.
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VERTICAL NAVIGATION
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The vertical view is displayed if two or more points have been
entered in the route.
 The blue line represents the aircraft. If climb and descent points
have been inserted, then the blue lines will be sloped,
otherwise they will be square.
 The brown line is the ground elevation directly along the flight
path.
 The gray line is the highest ground elevation within five nautical
miles of the flight path.
The Vertical Navigation view can be printed with the Map.
Printing in Portrait mode places the Vertical Navigation underneath
the Map on the same page.
Printing in Landscape mode places the Vertical Navigation and the Map on two separate pages.

Zoom In
 Press and hold the Ctrl button on the keyboard. Press and hold the Left Mouse Button and move over the area that you
want to view, then release.

Zoom Out
 Press the Right mouse button.

Climb and Descent






 Press the "Climb and Descent" button or go to the Top menu item "Route/Aircraft" to insert or remove climb and
descent waypoints.
Climb and descent rates are as specified in the Aircraft Performance.
Wind is taken into account.
TOC = Top of Climb.
DES = Start of the descent.
Note: 


It is better to remove climb and descent points when editing a route.
An alternate destination airfield is not displayed in the vertical navigation.

VFR:
 A leg with a height designated as VFR will be shown as a line joining the point 1500ft above the first point and 1500ft
above the second point of the VFR leg.

EasyPlan
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FLIGHT LOG
The Flight Log shows the route in table format. You can also plan your
flight in this format by simply adding the points of departure and
destination. Then check in MAP VIEW if any other points need to be
added. In the FLIGHT LOG you can adjust your altitudes.
Frequency Column - the frequencies are automatically calculated
according to which airspace you are entering and at what ALT/FL

Editing
 Mouse click in the 1st column to add, insert, delete a point or way
point.
 Mouse click on the light blue text to change the value.
 Mouse click on the Units to change them.
 Mouse click on the Heading in the top row to switch the column
off.

Alternate Destination is marked in RED. Go to Route/Aircraft. Set Alternate Destination on/off
En Route Info Column
This column is used to indicate a special event en route. (e.g. Touch & Go or No Fuel Stop )
Click on the EN-Route column to select options.
Touch and Go: An additional 6 minutes is added to the accumulated time and the corresponding amount of fuel is consumed.
Stop with no Fuel Added: When doing fuel calculations an extra 6 minutes and “taxi fuel” is added for each approach
and landing.
Stop and Fill Main and Aux Tanks from fuel pump: The fuel level in the Main and Aux Tanks is filled up to the level set
by the “Total Fuel Capacity Main Tanks” and “Total Fuel Capacity Aux Tanks”. See Aircraft Performance.
Stop and Fill Main Tanks from fuel pump: The fuel level in the Main tank only is filled up to the level set by the “Total Fuel
Capacity Main Tanks”.
Stop and Fill Aux Tanks from fuel pump: The fuel level in the Aux Tank is filled up to the level set by the “Total Fuel
Capacity Aux Tanks”.
Stop and Fill Main Tank from Aux: The available fuel in the Aux tank is transferred to the main tanks.


Note:  Fuel calculations and endurance ignore fuel added.
 Climb and descent points cannot be added if there is any touch and go or stop.

Flight Log Notes
These notes are saved, together with all the flight details, and can be printed with the Flight Log. Use for current Notams or
special instructions.
You can also add notes directly by right clicking on a border while in the map view.

Find All Air Spaces
Finds all the air spaces the route goes through, and lists them together with their frequency.
Searching can take a few minutes, depending on the length of the route, and speed of computer.

Find All NDBs and VORs
Finds all navigation beacons within 20 nm of the route and lists them together with their frequency
Note on formatting:

“.b” prints the line in bold.
“.h” hides the line. (Not printed).

10
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FL I G H T P L A N

FLIGHT PLAN

REPUBLIC OF SOUTH AFRICA

Updating and Checking

FF

Originator

Filing time

 The Flight Plan updates automatically if the 'Automatically Up-date FP' in the Units
& Preferences check box is ticked. Otherwise press the Button "Update & Check"
flightplan
 Data for the Flight Plan is extracted from the Aircraft details, the Flight Log and the
Weight & Balance.
 Note that the Fuel quantity comes from the Weight & Balance.

REPUBLIEK VAN SUID-AFRIKA

Addressee(s)

Priority

Specific identification of addressee(s) and/or originator

7

3 Message type

Type of aircraft

1

J 4 3 0

G

V
10 Equipment

Wake turbulence cat

/

G/C

L

Time

0 0 0 0

F A G M

Route

Level

Cruising speed

Type of flight

Flight rules

C U L

13 Departure aerodrome

15

8

Aircraft identification

Z U

(FPL
9 Number

DCT 2606S02803E 2600S02804E 2548S02803E
A 0 7 5
N 0 1 1 0
2537S02803E 2535S02803E/N0110F085 2532S02802E 2509S02753E 2446S02745E/N0110A065
DCT FATI DCT

Total eet

16

Hr.

Destination aerodrome

2nd altn. aerodrome

Altn. aerodrome

Min.

0 1 1 3

F a r m
18 Other information

OPR: AviationDirect P O Box 1635 Fourways 2055
RMK/SAR NML
Supplementary information (not to be transmitted in FPL messages)

The following fields in the Flight Plan will be updated automatically :
1. Departure Aerodrome
6. Destination Aerodrome
2. Departure Time
7. Total EET
3. Cruising Speed
8. Other Information: EET for FIR crossings
4. Level
9. Endurance
5. Route

Fi e l d 1 8

Emergency radio

19 Endurance
Hr.

E

/

P

/

0 0 4

R

/

/

E

V

U

Jackets

Survival equipment

S

Elba

VHF

UHF

Persons on board

Min.

0 6 0 6
polar

Desert

Maritime

Jungle

P

D

M

J

J

/

Light

Floures

UHF

VHF

L

F

U

V

Dinghies

Number

D

/

A

/

Capacity

Cover

Colour

C
Aircraft colour and markings

WHITE WITH BLUE AND YELLOW STRIPE
Remarks

N

/

C

/

Pilot-in-command

G H Antel

)

Filed by
Space reserved for additional requirements

09/06/2009

EasyPlan Ver 3.059.02 :- www.easyplan.co.za

Line 1: Used for EET. Automatically updated.
Line 2: Used for departure, destination and alternate info. Automatically updated.
Line 3: Used for OPR/ DAT/ COM/ and NAV/ fields. “NAV/GPS” inserted automatically if a “Z” selected in equipment and
no other NAV/ field is already entered.
Line 4: Used for SAR and any additional remarks. Note that the SAR must be last in the list. If touch and go is required add
“RMK/REQ T AND G FAGC FALA FAWB RMK/SAR NML”
More info on SAR: The correct way to file the SAR is as follows:
- RMK/SAR NML, not SAR/NML as “SAR” is not a recognized field identifier.
- SAR must be filed according to all the CAA accepted formats namely:
- RMK/SAR NML
- RMK/SAR NML ENROUTE
- RMK/SAR FAJSETA 1HR
- RMK/SAR NIL
- RMK/SAR FAJS1600

Fi l e 2 F l y

Create a FlightPlan in EasyPlan, make sure everything is correct.. Select
ICAO FlightPlan. Copy (CTL C) text.
LogIn to your: File2Fly - Go to FlightPlans & Briefings” - Flightplan Import
use CTL V or Paste to paste your flight plan into the space provided..
Select Import FlightPlan.

POINTS
Point Manager
EasyPlan Points: An extensive database exists of airfields and navigational aids in Southern Africa. This database is fixed, and
cannot be edited. Updates can be downloaded from the website
www.aviationdirect.co.za - Latest Updates - EasyPlan

User Points
Edit, add or delete User Points: (Note: a user point cannot have the
same name as an existing point in the main EasyPlan database.
Select the point required by entering the first few letters in the top edit
box, and then select the point from the displayed list.

EasyPlan

- 12 The following data is kept for each point:

 Name: name of the point. e.g. Grand Central
 Identification: ICAO code of airfield, VOR or NDB. e.g. FAGC, or HBV
 Type of point: Points are divided into 8 different categories. In Map View each type of point can be turned on or off.
A category Other can be used for your special destinations so that you do not have to have the map cluttered with
points that are of no interest to you.
 Latitude: Enter five or six digits for the latitude. (Depending on the settings in Units + Preferences). The point is assumed
to be in the South of the equator
 Longitude: Enter five or six digits for the longitude. (Depending on the settings in Units + Preferences).
The point is assumed to be in the East
 Frequency: Enter a frequency if required. This is saved as a text string.
 Info File: Enter the name of a text file that contains additional information on the airfield. The Open button is enabled if
a valid file exists. If no file exists, a file can be created or linked by entering the edit mode.
 Picture File: Enter the name of a .JPEG file that contains a picture of the airfield.
The open button is enabled if a valid file exists. If no file exists, a file can be created or linked by entering the edit mode.
 Elevation: Enter the elevation of the airfield.

Select Point
 Select the point required by entering the first few letters in the top edit box,
and then select the point from the
displayed list.

Edit Waypoint
 Change the Waypoint and press OK when complete.
 Check Include in Flight Plan if the point must be part of the Route
information in the Flight Plan.
 Check ‘Include in EET’ if the point must be included as part of the EET
information in the Flight Plan.
 When in MAP mode the Waypoint can be moved to
the Co-ordinates of the Mouse by selecting
At Co-ordinates and Clicking on “Mouse Co-ords”.

Go To Point
In the POINTS menu, select VIEW Points, select a point from the list and then select “GoTo On Map”

GENERAL
Edit Data
 Change the displayed data value and press OK.
Edit Memo
Edit using the standard Windows commands:

Ctrl X to cut text
Ctrl C to copy text
Ctrl V to paste text

Text can be copied from and to other Windows text editing applications.
Top menu options: (Click on File menu on the top left hand side)
 Save: Saves the current file being edited using the name shown in the title bar.
 Print: Prints the current file.

EasyPlan

- 13 Close Progam
To close the progam press the [X] in the top right hand corner. If changes have
been made without saving, you will be prompted to save the changes.

Edit Altitude
Enter the altitude or flight level. A value of less than 500 is interpreted as a flight level and greater as an altitude. Do not
enter the F or A. Some examples:
Enter
100
075
220
7000
1500
13000
VFR

Flight Log Display Flight Plan Display
FL100
F100
FL075
F075
FL220
F220
7000ft
A070
1500ft
A015
13000ft
A130
VFR
VFR

Meaning
pressure altitude, with sub-scale on 1013mb, of 10000ft
pressure altitude, with sub-scale on 1013mb, of 7500ft
pressure altitude, with sub-scale on 1013mb, of 22000ft
altitude above sea level of 7000ft
altitude above sea level of 1500ft
altitude above sea level of 13000ft
a VFR leg at 1500ft AGL

Edit Time
 Enter the time and press OK.

GPS INTERFACE
All Garmin GPS should be supported, although not all have been tested.
Connecting a GPS
 Plug GPS into computer serial port  Switch on GPS.
 Select the port number  Click on Open GPS Port.
 “GPS Detected” should be displayed if communication with the
GPS has been established. If not, check connections and port
number.
Some common problems
 Wrong communications port selected. Most computers use Com1
or Com2
 The Communications port is being used by another application.
Often cellphone communications software holds the port even
though the cell phone is not connected. When EasyPlan reports
“Error opening com port” then it is either not available on the
computer, or in use by another application.
 The Garmin protocol is not selected on the GPS. EasyPlan reports “Port Open” and “Msg Sent 0” but gets no response.
This indicates the GPS is not connected to the port, or is set on the wrong protocol. See the GPS Operating Instructions.

USB
 EasyPlan communicates with the Garmin GPSs using USB. It
works as the serial connection described above, except
“USB” must be selected instead of “ComX”. The Garmin drivers must be
previously installed.

Route Transfer
 Select a special GPS Character to be appended to a waypoint name
when the waypoint is not in the Point Database.
 The Special GPS Character is appended onto any waypoint to
differentiate between waypoints of the same name in different routes.
Waypoints modified are all that contain the letters: FIR, CTR, ATZ,
TMA, FAR, FAD, FAP, CTA, UTA, WPT, XPT, ABM, TOC and DES.

- 14  If you are downloading more than one route to the GPS ensure
you choose a different letter for each route, or ensure all names
in the routes are unique.
 Click on Check GPS Data. This converts the waypoint names into a
format suitable for the GPS and checks for duplicate names that do
not refer to the same point. Note that waypoint names are modified
to be meaningful using a length of six characters - the maximum
available in most GPS.
 Change the route name if necessary. A route with the same name
already in the GPS will be overwritten.
 Waypoint names can also be changed, but do so with care.
 Click on Download Route to send the current route to the GPS.

EasyPlan

Track Transfer
 Click on Get Tracks to read all the stored tracks from the GPS or
from EasyCockpit.
 Select the tracks to view the trace on the map.
 Tracks can be saved to disk.

Live Update
 On GPS that support position, velocity and time (PVT) data transfer,
a live update of position, velocity and time can be displayed on the
map. This option is not certified for navigation in the cockpit, so be
careful! Besides, computers can interfere with your primary navigation
equipment. See Map.
 Not all Garmin GPSs support the Live Update option.
 In the event of a problem, switch on DEBUG and email the
reported into to support@easyplan.co.za

Export to Google Earth
Your downloaded track can now be exported into Google Earth
AVMAP
On the GPS select “Communications” “Flightplan Upload”
On the PC select “Avmap’ and press “Check GPS data”, then “Download Route”.
LOWRENCE AIRMAP - SEE “EXPORT”

Transfer a Route to Lowrence Airmap or Enigma
To transfer a route/flight plan to Lowrence Airmap, use the EXPORT function on the toolbar and select Map Create. This will
save the file in your EasyPlan3 folder in My Documents. Copy this file onto a SD card and plug into the Airmap. The program
will pick up that file.
ENIGMA
To transfer a route/flight plan to the Enigma, use the EXPORT function on the toolbar and select Enigma. This will save the file
in your EasyPlan3 folder in My Documents. Copy this file onto a SD card and plug into the Enigma. The program will pick up
that file.
TRANSFER TO GARMIN AERA 500
Connect the Garmin Aera to your PC. It then appears as a Memory Device on your PC (My Computer). Open the route on
EasyPlan. Go to “EXPORT” and select “Create .gpx file” A folder called “GPX Files” is automatically created under My Documents - EasyPlan and the .gpx route is saved into that folder. Copy this file into the /GPX/AVIATION folder on the Garmin
device.. In the Garmin device: go to: “Active FPL - Menu - FLightplan List “ - choose Route - ACTIVATE FP
then select “Home” - Map to display
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LOG BOOK
General Info
 The logbook information is stored in LogBook.dat2
under “\My Documents\EasyPlan3”
 Press the "Save" button to save the Log Book.
The Log Book is automatically saved when closing
EasyPlan.
 Periodically make a backup of this file onto a removable
disk: File / Logbook / BACKUP
 Click RESTORE to restore your logbook to the last version saved on a removable disk. Use this only if you
have not made any additions to your LogBook on the computer or if you have lost data on your computer.
 Press "Print" to print the LogBook.
 Use the "Up/Down" buttons or the "Pg Up" and "Pg Dn" keys to navigate between pages of the Log Book.
With EasyLog you have a choice for the time format. Just ensure that Summaries are in the required format.
SACAA Requirements as per SA CATS 61.01
1. SA CATS 61.01 require holders of a flight crew licence to record details of all flights flown in a format acceptable to the SA Civil Aviation
Authority responsible for licence or rating issue. This logbook enables pilot licence holders to record flying experience in a manner which
will facilitate this process while providing a permanent record of the licence holders flying. Pilots who fly regularly aeroplanes and helicop
ters or other aircraft types are recommended to maintain separate logbooks for each type of flying.
2. The particulars of every flight in the course of which the holder of a flight crew licence acts as a member of the operating crew of an
aircraft are to be recorded in the appropriate columns using one line for each flight, provided that if an aircraft carries out a number of
flights upon the same day returning on each occasion to the same place of departure and the interval between successive flights does not
exceed thirty minutes, such series of flights may be recorded as a single entry.
3. Flight time is recorded from the time the aircraft first moves under its own power for the purpose of taking off until the time the aircraft
finally comes to rest after landing.
4. When an aircraft carries two or more pilots as members of the operating crew, one of them shall, before the flight commences, be designat
ed by the operator as the aircraft ‘commander’. The ‘commander’ may delegate the conduct of the flight to another suitable qualified pilot.
All flying carried out as ‘commander’ shall be entered in the log book as ‘pilot-in-command’. A pilot flying as ‘pilot-in-command under
supervision’ or ‘student pilot-in-command’ shall enter flying times as ‘pilot-in-command’ but all such entries shall be certified by the com
mander or flight instructor in the ‘Remarks’ column of the logbook.
Column 1 Enter date (dd/mm/yyyy) on which the flight commences
Column 2 Enter type of aircraft or Type or Classification of the CAA approved FSTD.
Column 3 Enter Registration Marks of aircraft or SA CAA authorisation number in the case of a FSTD.
Column 4 Enter name of pilot-in-command or SELF and in the case of instruction, name of student.
Column 5 Enter details of flight.
Column 6 Instrument Time: Enter the navigational aid used
Column 7 Instrument Time: Enter the place where the navigational aid was utilised
Column 8 Instrument Time: Enter the actual Instrument Time Flown
Column 9 Instrument Time: Enter the FSTD Instrument Time flown
Column 10 Instructor: Enter the time flown as a Instructor for Single Engine Aircraft (SE Civil). Ensure that the same flight time is entered as pilotin-command time Column 15 or 18 as appropriate (PIC).
Column 11 Instructor: Enter the time flown as a civilian Instructor for Multi Engine Aircraft (ME Civil). Ensure that the same flight time is entered as
pilot-in-command time Column 22 or 25 as appropriate (PIC).
Column 12 Instructor: Enter the time flown as an Instructor in a Flight Simulator Training Device (FSTD).
Column 13 Flight Simulator Training Device (FSTD): Enter the actual time flown in the FSTD.
Column 14 Flight Time: Enter the Dual time flown by day for single engine aircraft.
Column 15 Flight Time: Enter the pilot-in-command (PIC) time flown by day for single engine aircraft.
Column 16 Flight Time: Enter the pilot-in-command under supervision (PICUS) time flown by day for single engine aircraft. The pilot-in-command
(PIC) should verify this time by signature in the Remarks column, Column 34.
Column 17 Flight Time: Enter the co- pilot time flown by day for single engine aircraft.
Column 18 Flight Time: Enter the Dual time flown by night for single engine aircraft.
Column 19 Flight Time: Enter the pilot-in-command (PIC) time flown by night for single engine aircraft.
Column 20 Flight Time: Enter the pilot-in-command under supervision (PICUS) time flown by night for single engine aircraft. The pilot-in-com
mand (PIC) should verify this time by signature in the Remarks column, Column 34.
Column 21 Flight Time: Enter the co- pilot time flown by night for single engine aircraft.
Column 22 Flight Time: Enter the Dual time flown by day for multi engine aircraft.
Column 23 Flight Time: Enter the pilot-in-command (PIC) time flown by day for multi engine aircraft.
Column 24 Flight Time: Enter the pilot-in-command under supervision (PICUS) time flown by day for multi engine aircraft. The pilot-in-command
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(PIC) should verify this time by signature in the Remarks column, Column 34.
Column 25 Flight Time: Enter the co- pilot time flown by day for multi engine aircraft.
Column 26 Flight Time: Enter the Dual time flown by night for multi engine aircraft.
Column 27 Flight Time: Enter the pilot-in-command (PIC) time flown by night for multi engine aircraft.
Column 28 Flight Time: Enter the pilot-in-command under supervision (PICUS) time flown by night for multi engine aircraft. The pilot-in-command
(PIC) should verify this time by signature in the Remarks column, Column 34.
Column 29 Flight Time: Enter the co- pilot time flown by night for multi engine aircraft.
Column 32 A pilot flying as ‘pilot-in-command under supervision’ or ‘student pilot-in-command’ shall enter flying times as ‘pilot-in-command’
but all such entries shall be certified by the commander or flight instructor in the ‘Remarks’ column of the logbook.
6. All Type and Class Ratings, Aircraft Conversions, Operator Proficiency Checks, Skills Tests or Revalidations are to be entered in the
LOGBOOK ENDORSEMENT page which can be printed out separately.
• The Instructor Initials and Name must be entered.
• The Instructors Pilot Licence Number must be entered.
• The Instructors Designation, e.g. Gr III, Gr II, Gr I, Designated Flight Examiner (DFE), Official Examiner (OE), Authorised Person or
Authorised Officer must be entered.
• In the case of any training being carried out, the name of the affiliated Air Training Organisation (ATO) and its CAA Approval Number.
• The Date of the event.
• The Signature of the Instructor, Designated Flight Examiner (DFE), Official Examiner (OE), Authorised Person or Authorised Officer must
be entered.
• The nature of the endorsement, e.g. Conversion to BE 55 successful.
7 Where a flight is conducted for the specific purpose of meeting maintenance of competency requirement, this must be recorded on the line
of the particular flight; e.g. ‘Reg. 61.04.11(1) complied with’. Where currency was restored by means of a skill test or proficiency check, the
entry ‘Reg. xxx complied with’ shall be countersigned by the examiner.
8. Total Flying Time now includes Simulator hours, flown in a SACAA approved FSTD
9. SACAA Summaries and Licence Renewal forms must show hours in HOURS:DECIMALS. (HOURS and TENTH OF HOURS)

(Units & Preferences - Logbook)

Entering an Existing LogBook
If you have patience and not too many flying hours you can enter your entire Log Book from the beginning. The alternative
is the following:
 Enter a summary of the total time on each type filling in each of the columns (i) to (xv) as necessary, for all flying up to a
year ago.
 Choose a date over a year ago. (Otherwise the flying time calculated during the last year will be wrong).
 Enter the full details for the last year. This ensures all the summaries going back one year will be correct. You could take
a short cut here and enter a summary on each type for the year, but because EasyLog does not have all the information
the summaries may not be correct.

Entering Data
 Click in the field to edit.
 Use the Arrow keys or the Tab to move to the next field or next entry.
 Click one row down from the last entry to start a new entry. The previous entry is
the default data for a new entry.
 Right Click to bring up a menu to Insert, Delete, Copy or Paste a Log Book entry.
 Right Click to enter page breaks. It might be a good idea to duplicate the layout of the “Paper” version of the Log Book.
Right Click to Start New Page
 Use the PageUp and PageDown keys to navigate between the pages.
 Simulator time is assumed if instrument time is booked without any corresponding
flying time.
Note: Logbook entries over 100 hrs. round up or down on screen but show the correct hours:minutes when you move
the mouse over the values in the ‘total’ column, the summary, and on the print out. In Units + Preferences, you can
choose to show and print the logbook in a smaller and/or narrow font.

Systems
 Right click in the top row to Add, Delete or Edit an aircraft system.
 Left click in the top row to change column widths.
(These settings are saved when EasyPlan is closed).
 Left click in the first column to Delete an un-used aircraft type.
 Select "Update Aircraft" to update list of aircraft types.

- 17  Click in the blocks to toggle the "System" on and off.
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Summary
Summar y Times
 Select the Summary Times for each of the Summary Types. “All” will include all entries up to the current date. Entries with
a later date will not be included. “All as at” ... will include all entries up to the selected date. Use “Selected Dates” to find the
flying within a certain time period. The dates are inclusive.
Normal Summar y
 Select Summary type as "Normal".
 Choose the type of summary and the summary period.
 The summary is divided into Day, Night, Instrument, Dual etc.
Aircraft Summar y
 Creates a summary of flying time on all the different types of aircraft.
 Choose the summary period.
 Use Page Up and Page Down to access additional summary pages.
Sy s tems Summar y
 Select Summary type as "Systems".
 Choose the summary period.
Filter
 Use to find all LogBook entries with certain parameters. For example, find all
LogBook entries flown in ZS-JVU. Enter JVU in the Aircraft registration and press
“Update”. Dates can be entered to refine the search.
 The filter is not case sensitive.
 Fields left open are not included in the search.
 If more than one filter criteria is used then both need to be satisfied to be
included in the result.
Licence Renewal Application Form
 Enter the details to be printed on the Form. The flying time will be extracted
from the logbook


Note: You can use up to 3 LogBooks if you need to keep separate logbooks
for fixed wing, rotary, gliding, microlighting or the new Recreational
Logbook which comprises all.
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TOP MENU ITEMS
FILE
 To start a new route.
 Opens an existing route.
 Re-opens a route that you previously saved.
 Saves the current route.
 Saves the current route with a new name.
 Gives you the option of printing the Flight Log, Flight Plan, Map or Weight & Balance, or if you like to
print the Log Book, the Summary or the Renewal Form..
 Using the Print icon prints whatever page you have open at the time!

New
Open
Reopen
Save
Save As
Print



Tip:

Copy Image to
Clipboard
Copy Text to
Clipboard
Exit

Use the PRINT icon to print the current item being viewed.

 Copies the current view to the clipboard so that the image can be pasted into another program




Copies the Flight Log to the clipboard so that the data can be pasted into a Spread Sheet
or Word Processing progam.
Data is in Tab delimited form.
Closes EasyPlan.

RO U T E / A I RC R A F T
Invert Route
 The current route is inverted. If the heights are the same as the aircraft defaults for that direction, the inverted route will
have the correct heights for the new opposite direction.
If the “Alternate” function is on, a new Alternate destination must be selected.
Insert Climb and Descent Waypoints
 Calculates the Top of Climb (TOC) and the Start of Descent (DES) points using the aircraft details and the flight levels set
in the Flight Log. It is best to enter the complete route, and then calculate the climb and descent waypoints.
Remove Climb and Descent Waypoints
 Removes the climb & descent waypoints automatically inserted by using the previous function.
Set Alternate Destination On/Off
 If “Alternate” is on, the alternate destination is always the last point of the route and is displayed in a different colour in
the Flight Log and the Map. When “Alternate” is on, fuel calculations will be done to the destination and alternate
destination. Switching the “Alternate” function off does not delete a point, but changes the final destination to what was
previously the Alternate destination. The vertical display only includes up to the final destination.
Set Fuel and Speeds to Default Values
 All the fuel consumption figures and the airspeeds in the Flight Log will be set to the defaults as in the Aircraft section.
Import Route Data
 Extracts only the route part of the data from a previously saved route.

EasyPlan
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 Extracts only the aircraft data from a previously saved route. Use this if you have created a route and you want to fly the
identical route in a different aircraft.
Import V1.x Route
 Imports a route created in EasyPlan version 1 and saved as *.zsr files.
POINTS
New 
View 
Add 

Opens the Point Manager page ready to insert a new point in the user database.
Opens the Point Manager page showing a list of all points in the database.
Appends a point to the end of the route.

LO G B O O K
BackUp - Periodically back up the Logbook onto a disc.
Restore - Restore Logbook from disc
E A SY CO C K P I T
If you have EasyCockpit, this imports and exports routes to your pocket PC.
E X P O RT
Exports routes to various GPS, i.e. Lowrance via Map Create and Enigma. Exports also to Google Earth for viewing.
Lowrance 500
Instructions to export route to Lowrance Airmap 500
1. Click on “Export” and select “Map Create” and save your route as a text file.
2. Run MapCreate software.
3. Select “File” “Import” “Import Route” and select the saved text file.
4. Select “Save” “Save GPS Data File As” and save the route onto the memory card in “.USR” format.
5. Insert memory card into Lowrance GPS.
6. On the GPS, select “Menu” “System Setup” “Transfer My Data…” “Load”.
7. Load the saved “.USR” file.
8. Select “Route Planning…” and open the saved route.
9. Select “Navigate Route” to activate.
Lowrance 2000
Instructions to export Route to Lowrance Airmap 2000c
IN EASY PLAN:
1) Click on “Export” and select “Map Create” and save your route as a text file.(in a Folder you know you can find to recover
it - My Documents-Routes, remember the file name you will need it in step 3)
IN THE MAP CREATE SOFTWARE (supplied with the Lowrance GPS)
2) Select “File” - “Import” “Import Route” and select save text file saved in 1)
3) Select “Save”- Save GPS Data File AS” - Type in the File name given to the route in 1) above and the file will be now converted to a .USR format file and saved in the program “My GPS Data Folder”.
4) Put the GPS card into the card reader and connect to the computer’s USB port.
IN WINDOWS EXPLORER SOFTWARE
5) Transfer (copy) the Route >USR file from the Map Create “My GPS Data” Folder to the Card Reader (F Drive) My GPS data
is found under “Programs” - “LEI” - “Map Create” - “My GPS Data”
IN YOUR LOWRANCE GPS
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6) re-insert the card and start
7) Select “Menu” “System Set-up” “Transfer My Data” “Load” - Select the Relevant Route “user Data File and enter “Load”
8) Select “Route Planning” and open the saved route
9) Select “Navigate Route” to activate.
10) Take a well disserved rest
(Thanks to Richard Eyres for this contribution)

EASY WEATHER
How to download the weather overlays in EasyPlan…
After ensuring you have a valid EasyPlan subscription, the latest update of
EasyPlan
and a valid EasyWeather subscription, you will be able to download the weather
overlays.
 When EasyPlan opens, click on the ‘Weather’ tab. This will take you to the
correct section for downloading the overlays onto the map.







Select ‘Download Files’ to open the Weather Downloader window
From this window, you can select the Radar, Satellite, METARs, TAFs and
forecasts you wish to view.
Once selected, click download and when the download is complete,
close the Weather Downloader window
To see what you have successfully downloaded, click on ‘Read Files’
From there, select - by ticking the boxes – what you want to appear on
the EasyPlan map then select the Map tab to return to the hi-res topo
graphical map.
On the map, in order for the weather layer to appear, select the
lightning strike symbol along the tool bar.
To view METARs and TAFs in EasyPlan, select an airfield, right
click and select ‘ View’. Scroll till you find the METARs and TAFs.

 The Forecast symbols represent Wind Speed, Wind
Direction,
Temperature, Dew Point
and Cloud Cover at the
selected flight level.
RADAR:
EasyWeather uses the following colour coding to indicate the strength of the RADAR return
dbZ Rain rate
PINK
60
RED
50
ORANGE 40
YELLOW
30
GREEN
20
BLUE
10

(mm/hr) Comments
~200 Extremely heavy rain, severe thunderstorm, hail likely
~50 Heavy rain, thundershowers, some hail possible
~10 Moderate rain, showers
~3 Light rain
~1 Drizzle, very light rain
~0.2 Significant but mostly non-precipitating clouds
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Please take note that various atmospheric and environmental conditions can negatively affect radar data and caution should be exercised when interpreting the
information. Some of these effects include:
- Returns from mountains and other non-meteorological targets
- Attenuation of the radar signal when viewing weather echoes through areas
of intense precipitation (with C-band radars)
- Temperature inversions in the lower layers of the atmosphere
which bend the
radar beam in such a way that ground clutter
is observed where normally not expected
- The “bright band” which is a layer of enhanced reflectivity caused
by the melting of ice particles as they fall through the 0C level in the
atmosphere and which can result in over-estimation of rainfall.
SATELLITE - if temperatures reach below freezing point, the satellite
picture might show a thin layer of cloud.
EasyWeather has been developed by Aviation.Direct in a joint venture with
South African Weather Services.
It is available on a subscription basis and is
subject to a valid EasyPlan subscription.

Forum

Register on our Forum for advice, information and
tips from other EasyPlan and EasyCockpit users.
Our support staff will also respond to any queries
posted.

dir
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HO W T O U P D A T E
AviationDirect provide regular updates to EasyPlan,
generally airspace, airfields and navigation data updates
as well as product improvements. To be able to download
updates, your subscription has to be valid. The software
shows that information when EasyPlan is opened: “Update
Days Left: 345”
EasyPlan – Latest Updates – EasyPlan Updates

Downloading Updates
You can check which version of EasyPlan you have installed by going to: ‘Help’ > ‘About’ in EasyPlan.
The following window will appear displaying various
information relating to your EasyPlan:
To update your EasyPlan, please follow the instructions below:
1. Check you have a valid EasyPlan subscription to updates (you can check this by going ‘Help’ >
‘About’ in your EasyPlan – see ‘Update Days Left’)
a. If your subscription is valid, continue from point 2.
b. If your subscription is not valid, see Renewing Your Subscription to Updates further down this page
2. Download the latest EasyPlan Version 3.059_04 now - Go to www.aviationdirect.co.za > Latest Updates > EasyPlan
See Latest Version displayed in Yellow Text
3. Enter your Easy Plan Program ID (10 DIGITS BEGINNING WITH 2 OR 3 WITH A DASH INBETWEEN THE FIRST 5 DIGITS
AND THE LAST 5 DIGITS. Please call if you do not know your extended Program ID) in the space provided further down
the web page and click ‘Show Updates’ to reveal the updates available for you to download.
4. You have 2 options from here: ‘Run’ or ‘Save’
a. ‘Run’ the update if your EasyPlan is loaded on the computer you are currently downloading/working on. You should
be confident you will not need to install this update again at any stage.
b. ‘Save’ if you might have to install the update again (perhaps incase installation is cancelled before complete) or
if your EasyPlan is loaded on a PC that does not have direct internet access.
Make sure you remember where you save it to.
5. If you chose option a (Run) then continue to install by clicking ‘Next’ and ‘Install’ where requested. There will be a
message asking if you are sure you want to run the software as the publisher could not be verified. Continue by clicking
‘Run’ again. The Update will be complete when the registration window appears again for your EasyPlan.
NB: You must not change the location the updates save to.
6. If you chose option b (Save) then select the location where you want to save the download file. We recommend you
make a New Folder in My Documents called ‘EasyPlan Updates’. From there, let the update download and save into the
selected folder. When ready to install, double click on the download file in the folder you placed it and select the option
‘Run’. Follow the wizard steps and the registration window appears again for your EasyPlan once the installation is complete.
NB: You must not change the location the updates save to.

Renewing Your Subscription to Updates

You can check if your subscription to updates has expired by going ‘Help’ > ‘About’ in your EasyPlan program. This opens
a window the displays your current registration information. Look at ‘Update Days Left’ to check how many days you have
remaining on your current subscription.
EasyPlan subscription to updates work on an annual fee that allows users to download updates as and when available from
the website throughout their year of subscription. All users who purchase the software receive their first year subscription to
updates free. This is calculated from the date of product registration.
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If your subscription to updates has expired, transfer an amount of R264 (subject to increase) to reactivate your subscription.
NB! Please note that if you have EasyCockpit, you need to transfer R396 (subject to increase) to reactivate your subscription.
This will ensure your EasyPlan and EasyCockpit software can be updated. See the EasyCockpit page for more info…
Banking Details:

Nedbank Business Northrand
Account Number: 1469 005 948
Branch Code: 198-765
Account Name: Aviation Direct
Reference: YOUR EASYPLAN PROGRAM ID (2xxxx) and NAME

Content of Updates
EasyPlan Updates mainly contain updated airfield data, aeronautical information and communication frequencies. Updates
can also contain software upgrades and improvements.

How Frequent are Updates?
Major updates containing airfield and aeronautical information are available on average every 2 months. ‘Sub’ updates are
available when necessary between the major updates.

How will I know when a New Update is Available?
Aviation.Direct notify all their registered users of updates that are available for download. This is done via the email address
used to initially register the software.
Keep a check on our website for any ‘Sub’ updates as we do not notify by email for these.
www.aviationdirect.co.za > Latest Updates > EasyPlan

TIP S & T r o u b l e s h o o t i n g
Entering your Aircraft Data
Tip: open an existing aircraft type which is similar to yours (Route/Aircraft > Import Aircraft Data), then just change numbers
according to your aircraft's operating manual. "Save As" your aircraft registration and type.
Hi-Res data not displaying
- The ﬁles should be in c:\Program Files\EasyPlan\EasyPlan3\Dem
- They must be unzipped and have a “.hgt” extension
- Files must have the “Read Only” ﬂag cleared.
- You must be using EasyPlan version 3.030 or later
- Enable “Hi Deﬁnition Elevation” in “Units & Preferences” “Map”
- Move the slider on the map page to about the middle
- The ﬁle name refers to the bottom left corner of the block
You need only to download and unzip the ﬁles covering the area of interest
Note: The full EasyPlan program is NOT available for download because of the size of the topographical data. If you install
EasyPlan from a download, it will NOT display the topographical data.
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Q&A
I have discrepancies between the ﬂight log and ﬂight plan.. Some way points are missing from the ﬂight plan and changes in
ﬂight levels/altitudes are also missing.
On the ﬂight plan click on the top button “Update and check Flight Plan” to do just that.
Also go to “Units and Preferences” “Flight Log” and switch on “In Flight Plan” to see which points will be in the ﬂight plan.
User points that are part of a straight course without an altitude change do not need to be in the ﬂight plan
I have downloaded the latest update of Easy Plan from your web site and am getting an ERROR message that reads “Floating
Point Operation” when the program is started. Would appreciate if you could advise on a ﬁx for this problem.
If EasyPlan starts go to “Units and Preferences” “General” and press “Select Defaults” and then restart and see if this helps.
Also check the default height under aircraft data is not 0. Be carefull when you add any User Points, wrong co-ordinates also
cause this error.
Printig Issues:
I can’t print the map with the ﬂight plan on my printer.
I don’t have a printer connected to my laptop, is there any way I can email ﬂightlogs or maps?
Not being able to print the map is due to the program not recognising a certain printer. You can either print to ﬁle, and then
print the .bmp or .jpg image, or you can print to Adobe .pdf
No, this is unfortunately not possible but a good option is to print to a .pdf ﬁle and then email or print from there. Free programs are available from the following sites:
http://www.pdfforge.org or http://sourceforge.net/projects/pdfcreator/
I get this message after downloading the update: “Files Corrupt” please contact AviationDirect
You will receive this message if your internet connection has been interupted during the download. This means that the full
update is not available - you might see it in the size of the ﬁle (an update at the moment is more than 7MB). You need to
download the update again. BUT before doing so, you will have to delete the temp ﬁle that has been created (corrupted update), as it will run the corrupt ﬁle. To do this, open up Internet explorer, click on TOOLS and on INTERNET OPTIONS. Once
there, click on “DELETE TEMP INTERNET FILES” to delete the corrupted ﬁle. If you are running Mozilla Firefox, open page
- Select ‘TOOLS’. then select ‘CLEAR RECENT HISTORY’
If you cannot access the page, heres another option: close internet explorer, Click on START, go to CONTROL PANEL and
double click on INTERNET OPTIONS. Under the tab ‘GENERAL’, under the Temporary Internet ﬁles click on Delete ﬁles. In the
Delete ﬁles box, click to select the ‘Delete all ofﬂine content’ check box, then click on ok.
TROUBLESHOOTING DURING THE WEATHER DOWNLOADING:
URL Error 403: This means that the proxy server has a list of websites that they’re allowed to visit and EasyWeather isn’t on the
list. There is not much that can be done as authorization won’t help. This error has only been reported once so far.
URL Error 407: This occurs when the proxy server is set up to require authentication and so when you normally try to browse
the web at work with the browser you will get login dialog that pops up and asks for a user name and password. Our EasyWeather downloader doesn’t currently support proxy servers that require authentication, only regular proxy servers without
authentication. This is normally only an issue at ‘larger corporations’ and
doesn’t occur at most companies or from home using a regular ISP. Currently you have a couple of options in terms of downloading the weather at work:
- Ask the IT department to allow requests to http://easyweather.seanmcleod.com to bypass the proxy. - Use a dialup connection or 3G/GPRS connection from your work PC to effectively connect to another ISP and therefore bypass your work’s
proxy server.
LOGBOOK
The backup ﬁles are copies of the original. So they are not restored as the *.da1 ﬁles are. You need to do the following:
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1. Close EasyPlan
2. Go to “My Documents\EasyPlan3”
3. Rename the ﬁle “LogBook.dat2” to “Logbook_old.dat2”
4. Copy one of the backup ﬁles to the “My Documents\EasyPlan3” folder. Rename the ﬁle to: “LogBook.dat2”
5. Run EasyPlan.
There are 2 options to back up the logbook onto an external device:
Logbook on the tool bar - Backup. it will back up all the ﬁles into the normal folder, then the da1 ﬁle, which is the back-up ﬁle,
asks where to save, change the directory to there your memory stick is and save
or
all your logbook ﬁles are under My Documents - EasyPlan or EasyLogbook. Use Windows Explorer to copy these ﬁles into
an external device., like a memory stick. Also make a paper print out, if posssible, of your logbook page after inserting new
entries.

